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www.transitofvenus.com.au 

 

Transit of Venus – CLEA simulation 
 

Year Level : Years 10 to 12 (typically 15 to 18 years of age). 

Background : This exercise illustrates the phenomenon of transits. A transit of a 
planet occurs when a planet (Mercury or Venus) passes directly between the Earth 
and the sun, so that we see the dark silhouette of the planet move across the face of 
the sun. While transits of Mercury are relatively common, occurring once or twice 
every decade, transits of Venus are extremely rare, occurring no more than twice a 
century. The first transit of Venus ever observed occurred in 1639, and since then, 
only 5 transits of Venus have occurred, the latest in 2004. The next transit of Venus 
occurs June 6, 2012, and then not again until 2117.  
Despite being so rare, transits of Venus have played an important role in the history 
of astronomy. For the Venus transits of 1761, 1769, 1874, and 1882, many 
governments organized elaborate and expensive expeditions to remote parts of the 
globe so that astronomers could view the transit from several different sites. The 
reason for such interest is that transits of Venus provided a unique opportunity to 
determine the length of the Astronomical Unit, which is the average distance 
between the Earth and the sun, a fundamental scale in the universe. 

Aim : To determine the value of the Astronomical Unit using the simulation program 
TRANSITS OF VENUS AND MERCURY and to gain an appreciation of the historical 
role of science as a Human Endeavour. 

Shape of the Australian Curriculum: Science strands on focus areas. 

Content descriptors: Year 11 and 12 (as per Year 10) 

Science Understanding Science as a Human 
Endeavour 

Science Inquiry Skills 

Yr 10 

The universe contains features 
including galaxies, stars and solar 
systems and the Big Bang theory can 
be used to explain the origin the 
universe (ACSSU188)  

 

Yr 10 

Scientific understanding, including 
models and theories, are 
contestable and are refined over 
time through a process of review by 
the scientific community 
(ACSHE191)  

Advances in scientific 
understanding often rely on 
developments in technology and 
technological advances are often 
linked to scientific discoveries 

Yr 10

Plan, select and use appropriate 
vestigation methods, including field 

work and laboratory experimentation, 
to collect reliable data; assess risk 

dress ethical issues 
associated with these methods 
(ACSIS199)  

in

and ad

Select and use appropriate 
equipment, including digital 
technologies, to systematically and 
accurately collect and record data 
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(ACSHE192) 

  

People can use scientific knowledge 
to evaluate whether they should 
accept claims, explanations or 
predictions (ACSHE194)  

 

(ACSIS200)                 

 

Use knowledge of scientific concepts 
to draw conclusions that are 
consistent with evidence (ACSIS204)  

Communicate scientific ideas and 
information for a particular purpose, 
including constructing evidence-
based arguments and using 
appropriate scientific language, 
conventions and representations 
(ACSIS208) 

 

 

 

 

 

 

 

 

 

Please note: For this exercise you will 
have to download ‘THE TRANSIT OF 
VENUS AND MERCURY” from the 
following website. 

http://www3.gettysburg.edu/~marschal/clea/CLEAhome.html 

 

This lesson plan is a summary of the student manual that is supplied for this 
tutorial. All the information in this lesson has been extracted from the student 
manual, however, specific learning objectives and other information about 
transits can be found in the manual.  

 

 

http://www3.gettysburg.edu/%7Emarschal/clea/CLEAhome.html


 

BACKGROUND HISTORY 

With the establishment of the sun-centered Copernican planetary system in the 
1600’s, astronomers were faced with the question of the size of the solar system. 
Using observations of Tycho Brahe, Johannes Kepler was able to determine the 
relative sizes of the orbits of the planets in terms of the distance from the Earth to the 
sun, the Astronomical Unit. These values are shown in the table below. 

RELATIVE SIZE OF PLANETARY ORBITS  
Planet  Semi major Axis of Orbit (AU)  

Mercury  0.39 
Venus  0.72 
Earth  1.00 
Mars  1.52 

Jupiter  5.20 
Saturn  9.54 

 

Even though Kepler had calculated the relative scale of the solar system quite 
accurately, astronomers in those days did not have an accurate measure of the 
absolute size of the solar system, in other words the true number of miles in an 
Astronomical Unit. 

In 1715, Edmund Halley (of Halley’s comet fame), first proposed a workable method 
of determining the Astronomical Unit using observations of transits of Venus. 
Halley’s method involved a time-honoured way to measure distances using simple 
trigonometry. If two observers at different locations on the Earth could 
simultaneously view Venus as it passed in front of the sun, a northern observer 
would see the planet shifted to the south on the face of the sun with respect to what 
a southern observer would see. This shift, called parallax, depends on the distance 
between the two observers on the earth. If the parallax, Θ, is measured, and the 
baseline or distance B, that is the distance between the two observers, is known, 
then a simple trigonometric formula gives the distance between the earth and Venus, 
as shown in Figure 1 below.  
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Once the distance to Venus is known, the length of the Astronomical Unit can be 
found, since the distances between the sun and Venus and between the earth and 
Venus in Astronomical Units are known. 

Though Halley died in 1742 without ever seeing a transit, his method appeared so 
promising that astronomers began to prepare to observe the track of Venus across 
the sun at transits in 1761 and 1769. 

Britain and France sent major expeditions to observe the transits of 1761 and the 
transit of 1769. Captain James Cook’s famous first voyage to the South Pacific was 
undertaken to observe the 1769 transit of Venus from Tahiti. Although many of the 
observers had good weather during the transit, and though many measurements 
were taken, the results of these elaborate observations were somewhat 
disappointing. The best calculations from the observations in the 1700’s put it 
between 92 and 95 million miles. 

There were two transits again in the 19
th 

century, in 1874 and 1882, and even more 
elaborate preparations were made to observe the track of Venus across the sun. The 
United States, Britain, France, Italy, Russia, Holland, and Denmark all mounted 
expeditions. Technology had advanced by this time, and astronomers used 
photographs to record the position of Venus more precisely than they had been able 
to do a century earlier. But again, the results were not as good as hoped; as precise 
timing of the duration of the transit just was too hard to attain. 

There were no transits of Venus in the 20
th 

century, but by the time of the next transit, 
on June 8, 2004, Halley’s transit method had been superseded by several better and 
more precise methods of measuring the length of the Astronomical Unit, and the size 
of the solar system was known within a fraction of a percent error. Nevertheless 
transits remain of great interest, both as rare and beautiful manifestations of the 
movements of objects in the solar system and as opportunities to apply modern 
technology to classic methods of astronomy—let us do just that in the exercise that 
follows. 
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Pre reading information 

In order to assist with the understanding of this tutorial it is important that the 
meaning of the following terms is known.  
 
Angle Astronomical 

Unit 
Baseline Cartesian 

Coordinates 
Celestial 
Coordinates 

Declination Degree, 
Minutes, 
Seconds 

Inferior Planet Latitude Longitude 

Orbit Parallax Superior 
Planet 

Radian Right 
Ascension 

Solar Diameter Solar Radius Terrestrial 
Coordinates 

Transit Universal Time 

 
Complete the following crossword (using the words above) in order to help with your 
understanding of the above terms and use the internet, a textbook or dictionary if you 
are unsure of the correct response. Two words allow for a gap between them. 
 
Across 

 
3. About 110 times the diameter of the Earth. 
10. One of the two coordinates of the equatorial coordinate system, which in 

astronomy is comparable to geographic latitude, but projected onto the celestial 
sphere. It is measured in degrees north and south of the celestial equator. 

13. The path of a celestial body or an artificial satellite as it revolves around another 
body. 

14. An apparent change in the position of an object resulting from a change in 
position of the observer. 

15. The coordinate system that we use to locate places on Earth. 
17. A unit of angular measurement equal to one sixtieth (1/60) of one degree. 
19. A unit of angle measurement. 
20. The _________ of a location on the Earth is the angular distance of that location 

north or south of the equator. It is an angle, and is usually measured in degrees. 
21. Any of the five planets (Mars, Jupiter, Saturn, Uranus, and Neptune,) whose 

orbit lies outside that of the Earth. 
 
Down 

 
1. A geographic coordinate that specifies the east-west position of a point on the 

Earth's surface. It is an angular measurement, usually expressed in degrees, 
minutes and seconds. 

2. A coordinate system in which locations of points in space are expressed by 
reference to three mutually perpendicular planes, called coordinate planes. 

4. The figure formed by two rays sharing a common endpoint, called the vertex of 
the angle. 

5. The angular distance measured eastwards along the celestial equator from the 
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vernal equinox to the point at which the celestial equator intersects a great circle 
passing through the celestial pole and the heavenly object in question. 

6. A term used in reference to Mercury and Venus, which are closer to the Sun 
than the Earth. 

7. A coordinate system for mapping positions on the celestial sphere. 
8. A unit of angular measure equal to the angle subtended at the centre of a circle 

by an arc equal in length to the radius of the circle, approximately 57°. 
9. A unit of angular measurement equal to one sixtieth (1/60) of one minute. 
11. A time scale based on the rotation of the Earth. 
12. About 110 times the radius of the Earth. 
15. The astronomical event that occurs when one celestial body appears to move 

across the face of another celestial body, hiding a small part of it, as seen by an 
observer at some particular vantage point. 

16. Approximately the mean distance between the Earth and the Sun. 
18. A measurement, calculation, or location used as a basis for comparison. 
 
 

TRANSIT OF VENUS TERMINOLOGY 
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Solution  

Across 

 
3. SOLAR DIAMETER—about 110 times the diameter of the Earth. 
10. DECLINATION—is one of the two coordinates of the equatorial coordinate 

system, In astronomy is comparable to geographic latitude, but projected onto 
the celestial sphere. It is measured in degrees north and south of the celestial 
equator. 
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13. ORBIT—The path of a celestial body or an artificial satellite as it revolves 
around another body. 

14. PARALLAX—an apparent change in the position of an object resulting from a 
change in position of the observer. 

15. TERRESTRIAL COORDINATES—the coordinate system that we use to locate 
places on Earth. 

17. MINUTES—is a unit of angular measurement equal to one sixtieth (1/60) of one 
degree. 

19. DEGREES—a unit of angle measurement. 
20. LATITUDE—the _________ of a location on the Earth is the angular distance of 

that location north or south of the equator. It is an angle, and is usually 
measured in degrees 

21. SUPERIOR PLANET—any of the five planets (Mars, Jupiter, Saturn, Uranus, 
and Neptune,) whose orbit lies outside that of the earth. 

 
Down 

 
1. LONGITUDE—is a geographic coordinate that specifies the east-west position 

of a point on the Earth's surface. It is an angular measurement, usually 
expressed in degrees, minutes and seconds. 

2. CARTESIAN COORDINATES—a coordinate system in which locations of points 
in space are expressed by reference to three mutually perpendicular planes, 
called coordinate planes. 

4. ANGLE—is the figure formed by two rays sharing a common endpoint, called 
the vertex of the angle. 

5. RIGHT ASCENSION—the angular distance measured eastwards along the 
celestial equator from the vernal equinox to the point at which the celestial 
equator intersects a great circle passing through the celestial pole and the 
heavenly object in question. 

6. INFERIOR PLANET—a term used in reference to Mercury and Venus, which 
are closer to the Sun than the Earth. 

7. CELESTIAL COORDINATES—a coordinate system for mapping positions on 
the celestial sphere. 

8. RADIAN—A unit of angular measure equal to the angle subtended at the center 
of a circle by an arc equal in length to the radius of the circle, approximately 57°. 

9. SECOND—is a unit of angular measurement equal to one sixtieth (1/60) of one 
minute. 

11. UNIVERSAL TIME—is a time scale based on the rotation of the Earth. 
12. SOLAR RADIUS—about 110 times the radius of the Earth. 
15. TRANSIT—is the astronomical event that occurs when one celestial body 

appears to move across the face of another celestial body, hiding a small part of 
it, as seen by an observer at some particular vantage point. 

16. ASTRONOMICAL UNIT—is approximately the mean distance between the 
Earth and the Sun. 

18. BASELINE—a measurement, calculation, or location used as a basis for 
comparison. 

The data for the CLEA Transit of Venus exercise consists of three series of images 
taken with these GONG (Global Oscillation Network Group) solar telescopes on 
June 8, 2004:  

54 images from El Teide between 7:05 and 11:35 Universal Time  
39 images from Udaipur between 5:15 and 10:50 Universal Time  



36 images from Learmonth between 5:00 and 8:50 Universal Time 
  

Two sample images from this set are shown in Figure 2 below.  
 

A note about the images: they are 860 x 860 pixels in size, and oriented so that north 
is up and west is to the right, the same as we would see the sun in the sky in the 
Northern Hemisphere. The solar disk is about 720 pixels across on each image 
and each pixel corresponds to 2.5 arc seconds. Venus moves across the sun 
from east to west (left to right) during the transit. The shift we expect to see in the 
position of the silhouette of Venus between the various observing sites is only a few 
pixels, but it is easily measured on these digital images using the software provided 
in this exercise.  
 

 
 
Figure 2: Two typical images of the Sun from GONG showing both the sun and the 
silhouettes of Venus as it transited from east to west across the sun on June 8, 
2004 . Arrows have been added to indicate directions on the sky. 
 
 
 
Basic Strategy: Using the GONG Images of the Transit.  
 
Your primary task is to compare the tracks of Venus across the sun as seen from a 
pair of GONG telescopes at two different observing sites and determine the angular 
shift or parallax, π

m 
, in seconds of arc, between the two tracks at one particular time. 

From the value of that angular shift, and the known distance between the two sites, 
you can then determine the distance between the earth and Venus. The basic data 
are the images from the GONG telescopes. From them, you plot two tracks, and 
from the plot you measure the angular shift. A sketch of the two tracks and the 
angular distance you will be measuring is shown in Figure 3. 
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Figure 3: The tracks of Venus across the sun as seen from two sites. Also shown are 
the appearance of the silhouette of Venus from the two sites as seen at the same 
time, and the observed parallax of Venus, π

m
 .  

 
Here are some questions you should ask yourself, and which you should try to 
answer when looking at the images:  

 
• If one observing site is further north on the Earth than the other, which 

transit track should appear the farthest north on the sun? Why?  
• Which transit track should appear the farthest south on the sun?  
• The observing sites also differ in that they are spread out east to west 

on the earth. If observations of the silhouette of Venus are made at 
exactly the same time (UT) from all three sites, which site will see 
Venus further to the east on the sun? Which site will see Venus further 
to the west?  

• Since there are three sites, how many parallax shifts could you 
measure from the data? Is it better to use just one, or to measure all of 
them and take an average?  

 
CALCULATING THE ASTRONOMICAL UNIT FROM THE MEASURED 
PARALLAX OF VENUS  
You have measured a parallax π

m 
from your observations of the transit from any two 

sites. (Be sure to express this in arc seconds. If your value of the parallax is in 
fractions of the radius of the sun, be sure to multiply it by the number of arc 
seconds in the radius of the sun. The solar disk is about 720 pixels across on 
each image and each pixel corresponds to 2.5 arc seconds.)  
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In addition to the measurement of π
m

, there are a few quantities that you need to 

know in order to calculate the length of the Astronomical Unit. The CLEA software 
will help provide them for you:  
 

•  The baseline, B between the two sites in kilometres, measured in a 
direction perpendicular to the line of sight between the centre of the 
earth and the sun. The CLEA software includes a simple program that 
calculates this, given the Universal time of the observation, the celestial 
coordinates (right ascension and declination) of the sun, and the 
terrestrial coordinates (latitude and longitude) of the two observing 
sites.  

•  The distance between the earth and Venus, D
ev 

and the distance 

between the earth and the Sun (in astronomical units), D
es 

at the time 

of the eclipse, expressed in Astronomical Units (you don’t yet know 
what the absolute value of the Astronomical Unit is, but you do know 
the relative distances in the solar system in AU.)  

 
The simple formula you use to calculate the length of the Astronomical Unit A in km 
is:  

A= B • (Des - Dev) • 206265  
π

m
• D

ev
• D

es 
 

 
CAUTION: Be sure your units are correct before you plug into this formula. B is in 
km, D

ev 
and D

es 
are both in AU, and π

m 
is in arc seconds!  

 
 
 
Here is a summary of what you will be doing:  

 
OBSERVATIONAL DATA (what you measure or are given):  

•  The parallax of the silhouette of Venus as seen at a particular time 
from two sites, determined from plotting the positions of Venus on two 
series of GONG images  

•  The baseline between the two sites, determined by knowing the 
latitude and longitude of the sites and the particular time of the 
observation (which determines the direction to the sun.)  

•  The distance between the earth and Venus and the earth and the sun 
in Astronomical Units at the particular time of the observation, which is 
known from KEPPLER’S laws.  

 
WHAT YOU CALCULATE FROM THIS:  
 

• The length of the Astronomical Unit in Kilometres.  
 
 
 

 
 
 
 



 
 
 

A USER’S GUIDE TO TRANSITS OF VENUS AND 
MERCURY 

A Program for Displaying and Measuring Transits 
across the Sun 

 

Position the mouse over the icon Transit lab  or menu bar and click to start 
the program. When the program starts, the CLEA logo should appear in a window on 
your screen. Go to the File menu at the top of that window, click on it, and select 
the login option from the menu. Fill in the form that appears with your name and 
laboratory table number. When all the information has been entered to your 
satisfaction, click OK to continue, and click “yes” when asked if you are finished 
logging in. The opening screen of the Transits of Venus and Mercury lab will then 
appear. 
 
Click on the file menu and choose Run. Click on 2004 Venus Transit.  

 
When you first run the program you will see a Main File List area with two frames, 
the left labelled Loaded Image List and the right labelled Image Database 
Directory. Both will be blank. Click on the File menu and then Image Database, 
Image Directory and Load.  You can load a database of images taken during the 
transit from one of the three observing sites (double click with the left mouse button 
on Teide, Canary Islands). After you load the image database from the File menu, 
you will see a list of the available GONG images, ordered by Universal Time of the 
image, in the Image Database Directory. 

 
Right-click on the Image Database Directory box which will give you a set of 
selection and display choices. Click on Select all  and then right click on the 
Image Database Directory again and select Load Selected Images. It may take a 
minute or so for them all to load, and while they are loading you will see them appear 
one by one in a display window on your screen while a window displays the progress 
of the load (the percentage of files loaded). When all files have loaded, click the OK 
button on the window which has been listing the progress of the load. You will notice 
an image of the Sun appear and this is the final image in your Loaded Image List. 
You can display any of the images in the Loaded Image List window by double 
clicking on the image time. (You can also use the right mouse button to bring up a 
pop-up menu that will allow you to display the image, remove it, or remove all the 
images currently loaded) . 
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Figure 4: Main window and image display window. 
 
Animating a Series of images  
 
Once you have a series of images loaded, you can have the program display each 
one in sequence automatically as an animation. This is a nice way to watch the 
entire transit in “fast motion”. You can do this in either of two ways. On the main 
menu bar over the list of images, select the Images option, then select Animation. 
Or on the menu bar over the Image Display window, select Animation---On. The 
rate of the animation (how long it displays each image) can also be set from this 
menu bar. You can stop the animation using the same menu bars.  
 
Measuring the Positions of the Silhouette of the Transiting Planet  
 
The most notable feature on all the images is the silhouette of Venus. In order to plot 
the track of the planet across the sun you need to measure the position of this 
silhouette on every image of the series. It’s a bit tedious, but the software makes it 
very easy.  
 
The image display permits you to measure the positions of points on the image, and 
it will automatically measure the coordinates of the centre of the silhouette. To start 
measuring silhouette positions, begin at the top of the Loaded Image List, and by 
left clicking on each image date one by one, find the first one on which the entire 
silhouette appears furthest to the left. (The first few may not show the silhouette, or 
may only show part of it).  
 
To measure you need only left click on the displayed image, or you can choose 
File---Image---Measure from the menu bar at the top of the image display. A small 
window will appear with digits to indicate the position of the cursor in pixels and in 
solar radii (fractions of the apparent radius of the sun). The position of the cursor is 
updated whenever you click the left mouse button, or continuously if you hold the 
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button down. You will also see a small magnification window that shows the area 
around the cursor. (see figure 5). This will allow you to locate the centre of Venus in 
the crosshairs.  

 
Figure 5: Measuring the positions of silhouettes on the images. 
 
Recording Data  
 
Once you have located the centre of Venus for the first image you will want to record 
the data. When you are measuring silhouette positions, there will be a small window 
on the screen (usually at the lower left) labelled Measurement Data. When you click 
the “record” button, the image date and time and the position of the cursor are 
written to a data file. If your instructor has turned on the “automatic centroiding” 
feature, which is usually the case, the software will calculate the precise centre of 
the silhouette beneath the cursor when you click the right mouse button. ( If the 
automatic centroiding feature is not turned on, place the cursor as close to the centre 
of the spot as possible before recording the position. ) The small magnification 
window helps by giving a magnified view of where the cursor is pointing, and the 
amount of magnification can be set, if desired, using a menu on the magnification 
window. The computer remembers whether you’ve measured a particular image, and 
will not let you measure it twice. (See the next section to find out how to delete 
erroneous data). 
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Figure 6 : Recorded data listings. 
 
Saving Data  
 
When you have completed measuring all the positions from Teide, Canary Islands 
save the data; you may, in fact want to save the data even before you have finished 
from the site just to guard against loss. Simply use the File—Measurement Data—
Save Data menu on the mail window and give the file a name. Then if you make a 
mistake or the computer system crashes, you can retrieve the data without having to 
remeasure it. 
 
Seeing Tables and Plots of Recorded Data  
 
At any time after you have some data recorded, you can view all the recorded data in 
a separate Transit Measurements window. To do this, go back to the Main File List 
window and choose File---Measurement Data from the main menu bar. There are 
choices that let you view the current data, or load a file of previously saved data. If 
you choose to view the list, you will see the data window appear on the screen. (see 
Figure 6 above). The columns are labelled; the observing site is at the top, and the x 
and y position of the centre of the planet on each image is given in units of fractions 
of a solar radius. In addition to the date and time of the observation, the window will 
list the Julian Date of the observation, which is a running day number and fraction 
that is convenient for keeping track of astronomical times.  
 
You can print the data in the Transit Measurements window by choosing List---Print 
from the menu bar. You cannot edit individual measurements, since they were made 
automatically when you clicked on the image on a picture; but if an entry seems to 
be in error, you can delete it by selecting the line (with a left click of the mouse), and 
using the Edit menu on the menu bar to select Delete Selected Line.  
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It is also possible to view the measurements you are making in graphical form, 
against a circular image of the sun. Simply click on the Analysis item menu bar on 
the main window and select Plot/Fit Data. A window will open showing a plot of 
your position measurements as small circles, connected by straight lines to 
represent the track of the planet across the face of the sun. The View choice on the 
menu bar of this window will allow you to see the track on the scale of the whole sun, 
or a magnified view (Detail). The magnified view is especially useful when 
comparing the tracks as seen from two or three sites, because the difference 
between the tracks is small and can best be seen when magnified. 
 
 

 
 
Figure 7: Graphical plots of measurements show the track of the planet across the 
sun.  
 
On the left is a full disk view; on the right, the magnified view. 
 
Measuring tracks from a second site  
 
You will want to measure the transit tracks from Learmonth, Western Australia. To 
view the images from another site, just go back to the main window, File --- Image 
Database---Image Directory---Load choice and double click on the listing for 
Western Australia. Select all the images from this site.  Right-click on the Image 
Database Directory box which will give you a set of selection and display choices. 
Click on Select all  and then right click on the Image Database Directory again 
and select Load Selected Images. When all files have loaded, click the OK. You 
will need to measure as you did for the first. GO BACK TO PAGE 12 :  Measuring 
the Positions of the Silhouette of the Transiting Planet and follow the procedure 
to take measurements of the new photos.  
 
Data will be added to the same data list you started for the first site, with new entries 
labelled as being from the second site. Once finished you can now view the plots of 
both tracks on the graphical display window under Analysis then Plot/Fit Data 
either on the scale of the full solar disk or as magnified “detail” view.  
 
Measuring the Parallax between the Tracks and Computing Baseline and 
Distance Data.  
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Once you have measured the tracks of the transit from at least two sites, you are 
ready to measure the parallax of Venus as seen from the two sites. Basically, all you 
need to do is select a time when Venus was visible from both sites, and the 
computer will compute the angular difference between the two tracks. If it is not 
already open, open the Analysis---Plot/Fit Data window. Then on the plot window 
select View---Detail so you can see the plots more easily. The computer connects 
your measured observations from a given site with a line to produce a track across 
the sun from each site---you can select either best fit straight lines or a parabola 
(quadratic) using the Data---Curve Fit menu on the plot window. Then select a time 
to calculate the parallax by using the Data---Select Observation time menu item. A 
slider will appear at the bottom of the screen, and as you move it back and forth you 
can see somewhat larger circles appear on the tracks which mark the position of the 
silhouette of the planet as seen from each site. Pick a time in the middle of the 
observation period when the planet is visible from all the sites. Click OK. 
 

 
Figure 8: Venus Transit Select Observation Time 
 
Once the observation time has been set, you can now read out all the information 
you need simply use the Data---Sun, Planet, Baseline Data choice plot window, 
and you will get a window called the Transit Analysis Ephemeris and Baseline 
Report listing all the information you need to insert into the formula for the 
Astronomical Unit on page 10.  
That information is: 
The “Measured Parallax” in solar radii at the time of observation, which is essentially 
the distance between selected tracks as seen from a particular two sites. You will 
need to convert that into seconds of arc using the apparent diameter of the sun at 
the time of the observation, measured in arc seconds (this is twice the solar radius, 
of course). Divide the apparent diameter by two to get the radius and then multiply 
the measured parallax to convert the parallax into arc seconds. 
 
The distance from the Earth to Venus, D

ev 
at the time of observation, in AU.  
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The distance from the Earth to the sun Des at the time of observation, in AU.  
 
The “Projected Baseline”, the distance between the two sites perpendicular to the 
direction to the sun, measured in km (note that miles are also given, but you want 
km).  
 
At this point you can print out the data on the report form using the List—Print menu 
choice on the Transit report window.  
 

 
 
Figure 9: Report windows showing data derived from the observed tracks of Venus 
across the sun. 
 
The data can then be inserted into the equation for the Astronomical Unit on 
page 10, and the length of the Astronomical Unit calculated. 
 
The simple formula you use to calculate the length of the Astronomical Unit A in km 
is:  

A= B • (Des - Dev) • 206265  
π

m
• D

ev
• D

es 
 

 
CAUTION: Be sure your units are correct before you plug into this formula. B is in 
km, D

ev 
and D

es 
are both in AU, and π

m 
is in arc seconds!  

 
COMPARE YOUR CALCULATION WITH THE KNOWN VALUES OF THE 
ASTRONOMICAL UNIT IN KILOMETERS. 
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